Bungie Software License Agreement

By opening the disk envelope, you agree to the terms and conditions of the following license
agreement. If you do not agree with the following terms and conditions, return the unopened
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disk envelope and package to place of purchase for a full refund. Bungie Software i ) b\ | TEY T
("BUNGIE") is the owner of the software contained in the disk envelope. You are being ! "l I‘J l{j‘ l l ()l\ :

granted a non-exclusive right to use the program within the disk envelope under the terms set

out below. j b\ | “ b\ 4 ‘ ‘l‘ FEY
Permitted Uses: You may use the software on a single computer at any one time. You may | l) I‘J k l‘_‘ l{ l L l () l{ Nl

physically transfer the program from one computer to another, provided that the software is
used only at one computer at a time. You may sell or give the software to another party,
provided that the other party agrees to be bound by the terms of this License Agreement. You !

may make one copy of the program solely for backup purposes. The copyright and other o
notices on the diskette must be reproduced and placed on the backup copy.

Prohibited Uses: You may not make more than one backup copy as permitted above. If you i

should wish to copy or use the software on more than one computer at the same time, contact il
BUNGIE. You may not distribute, lease, rent, sublicense or loan the software or
documentation to any other person. You may not electronically transfer the software from I

one computer to another computer or provide use of the software in a computer service
business, network, time-sharing, or multiple-use agreement. You may not modify, translate,
or reverse engineer the software. 3

Term: You may terminate this license agreement by destroying the software and
documentation and any copies. This license will also terminate if you fail to comply with any
term or condition of this agreement. Upon termination, you agree to destroy all copies of the
program and documentation.

Limited Warranty on Software Materials and Media: BUNGIE warrants that the manual
and the software media are free from defects in materials and faulty workmanship under
normal use for a period of ninety days from the date of original purchase. In the evéent of any
physical defects in the software media during the ninety days after purchase, BUNGIE will
replace the software media at no charge to the original purchaser after proof of purchase. If
the failure of the software media, in the judgement of BUNGIE results from accident, abuse or
misapplication of the media, BUNGIE will have no responsibility to replace the media under
this warranty. ALL IMPLIED WARRANTIES ON THE SOFTWARE MEDIA,
INCLUDING IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE, ARE LIMITED IN DURATION TO NINETY (90) DAYS*
FROM THE DATE OF ORIGINAL RETAIL PURCHASE. THE MANUAL AND THE
SOFTWARE ARE SOLD "AS IS". THE PURCHASER ASSUMES ALL RISK AS TO ITS
QUALITY AND PERFORMANCE. IN NO EVENT WILL BUNGIE BE HELD LIABLE
FOR DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES
RESULTING FROM ANY DEFECT IN THE SOFTWARE, THE MEDIA, OR ITS
DOCUMENTATION. Your sole and exclusive remedy in the event of defect in the media is
replacement as provided above. THE ABOVE WARRANTY AND REMEDIES ARE *
EXCLUSIVE AND IN LIEU OF ALL OTHERS, WHETHER ORAL, WRITTEN, EXPRESS
OR IMPLIED. No employee, dealer, or agent is authorized to make any modification,
extension, or addition to this warranty. Certain states do not allow the exclusion or limitation
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of incidental or consequential damages, so the above limitation may not apply to you. -
BUNGIE retains all rights not expresslygranted. Nothing under this agreement constitutes a

waiver of BUNGIE's rights under the U.S. Copyright Laws or any other state or federal law.

This manual and the software accompanying it are copyrighted with all rights reserved.
Neither the manual or the software may be copied, in whole or in part, without written consent

of Bungie Software, except in the normal use of the software as provided by the U.S.
Copyright Law or to make a single backup copy. The backup copy may not be sold or given

to another person except as part of a set that includes the original copy. Macintosh is a 1
registered trademark of Apple Computer, Inc.

© 1991 Bungie Software




OPERATION: DESERT STORM

© 1991 Bungie Software

Bungie Software is:

Alexander Seropian: Vocals and Bass
Phil Candela: Lead Guitar
Nick DiCrescenzo: Drums and Percussion
David Seropian: Piano, Synthesizer, and Organ

Many Special Thanks to:

Richard Seropian, Laura Feddersen, Ken Kries,
Robert Catania, Paula Pearson, Lawrence Gryziak,
Eric Zylstra.

If you would like to donate money to the Red Cross:

1-800-842-2200

Gulf Crisis Fund

C/O Financial Dept.
American Red Cross
43 East Ohio

Chicago, Illinois 6061 |

- - PLEASE DON'T COPY - -

If you want us to make more games, please do your part and
refrain from using or giving away copies. (Saddam Hussein
pirated software all the time, and you don't want to be like
him, do you? Besides, look at where it got him.)

P.O. Box 7877, Chicago, Illinois 60680-7877

Introduction

Welcome to Operation: Desert Storm! In this game, you
command an M1A1 Abrams tank on a series of twenty missions in
the Kuwaiti Theater of Operations. Your objectives include the
destruction of Iraqi nuclear plants and chemical warfare facilities,
the elimination of SCUD missile launchers, and more. Arrayed
against you will be a formidable combination of enemy tanks,
aireraft, land mines, poison gas and artillery. You’ll have to think
and respond quickly to get the job done and bring your crew
home!

Also included in this game is information regarding the geography
and peoples of the region, their industrial and energy resources,
the types of weapons used in the conflict, and an analysis of the
actual battlefield maneuvers which brought victory to the Allied
nations on February 27, 1991. We hope that this information will
broaden your understanding of the conflict, the region, and its
people.

This manual assumes that you have read Macintosh, the Macintosh
owner's manual. You should know how to point, click, open
applications from the Finder, and choose commands.

To play Operation: Desert Storm, you must use System 6.0 or
higher on a Macintosh Plus, SE, Classic, LC, SE/30 or a member
of the Macintosh II family. ;

You may transfer the Operation: Desert Storm folder to your hard
disk, but make sure the Logistics file remains in the same folder as
the Desert Storm Application.

You may not change the name of the 'Logistics' file or put it in a
different folder than the application; doing so will result in an
error.

You may remove the 'NewsSounds' file to save space, but you will
no longer get war coverage updates when running the application.

Also, Operation: Desert Storm may be hindered if your system
has many INITs installed. If this happens, you can disable the
INITSs by holding the shift key down during your computer's start
up cycle.
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Warplan Summary:
* Operation: Desert Storm contains twenty missions.
* To start, you must enlist in the Allied forces.

* Each mission begins when you are dropped off, or “released” in
the Theater of Operations.

* You must then proceed to the objectives and attempt to destroy
or disable them.

* Then you must proceed to the pickup, or “extraction” points.

* If you are successful, you will advance to the next mission. If
you complete all twenty missions, victory is yours!
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Enlisting in the Allied Forces
* Open the Desert Storm application from the Finder.

* (Choose the Enlist command from the File menu to receive
your first mission briefing.

The Mission Briefing screen appears.

M('ﬂﬁllgl‘ COHMBAT ZONE: Burgan, KUHAIT (17)
bt | CENTCOM: ->SAMOS: SCUD Missile Launchers located: Burgan. ..
“(l\ i Destroy SCUD Missile Launchers. ..

| AFSOUTH: Republican Guard troops.
||| RELERSE TIME (16 1 - COORDINATES (04-001
EXTRACTION: TIME [19 ] - COORDINATES [05-021

Overview Map

Current ; m
Coordinates Lt
and

Descriptions

The Briefing screen contains a message box, a map of the local
arca of operations (lower left), and a map of the Middle East
(lower right). The message box tells you the location and
objective of the mission. It also displays the coordinates of your
release and extraction. If you click on the Map of the Middle East,
it will change to a map of the Kuwaiti Theater of Operations.

You can find out where the extraction coordinates are by moving
the pointer over the mission map. The coordinates are displayed
in the lower right box. You can also determine the identity of the
battlefield objects by pointing at them; a description appears in the
lower left box.

Clicking the Print Map button prints the current mission’s map.
Clicking the Go AWOL button returns you to the title screen.

* Click the Charge! button to begin your mission!



Beginning a Mission

When the mission begins, you are released by an Armored
Transport Delivery Vehicle. You will have to meet the same
vehicle at the designated time and place to complete the mission.
When ready, hit any key to exit the delivery vehicle.

To board, drive
into the mouth
of the vehicle.

Armored Transport
Delivery Vehicle

Operating The M1A1 Abrams Tank

There are five movement controls for your tank: Forward,
Reverse, Stop, Left, and Right. Initially, they are configured for
numeric keypad users (keys 8, 2, 5, 4 and 6, respectively).
Additional controls include a “fire” key for your 120mm cannon
(Spacebar), a TOW missile launch key (B), and a key to put on or
take off your gas protection equipment (G). You can pause and
resume at anytime with the P key, and you can self-destruct with
the Q key. To change this configuration, choose the Keyboard
Setup command from the Options menu.

Your tank cannot fire the cannon or launch TOW missiles while
the gas protection is on.

Your tank is equipped with an Overdrive mechanism, which may
be engaged by holding down the Shift key while hitting the

- Forward key. Overdrive is disengaged when another key, such as
Stop, is hit. Be careful, though: the Overdrive mode uses fuel less
efficiently and makes you more vulnerable to land mines.

Largest Armed Forces in 1988

Actives Reserves

USSR 5,100,000
China 3,200,000
United States 2,165,000
India 1,365,000
Iraq 1,000,000
North Korea 842,000

6,200,000
1,200,000
1,676,000
250,000
650,000
540,000

You will lose a tank if you:

* Are shot by the enemy.

* Collide with the enemy’s equipment. _

* Enter poison gas without wearing gas protection gear.

 Hit a land mine.

* Run out of fuel. To replenish your fuel, look for extra
fuel pods (shown below) on the battlefield which were
pre-positioned by the Special Forces Unit.

& ®

The MIAI TOW Missile Extra Fuel

On the right side of the screen is your instrument panel:

Score
Fuel Level
Missile Supply

Mine Indicator
i Gas Protection Indicator

¥ Current Time
§ Current Coordinates

Y Extraction Time
Extraction Coordinates

P Strength Indicator
I} Tanks Remaining

You may carry up to eight TOW missiles.

The Mine Indicator alerts you whenever you approach a mine. If
this happens, you should stop and back up.

The Strength Indicator tells you how many hits your armor will
absorb, A heavier border indicates a stronger tank. Your armor
strength will increase as you complete missions.

* The Ba'ath Party came to power in Iraq in 1968 and
has been led since 1979 by Saddam Hussein.

* In 1981, Israeli war planes destroyed an Iraqi nuclear
slant near Baghdad.

* The Iran-Iraq war began in 1980 and ended in 1988.




Your score is also credited at the end of the mission for destroying

Scor mng the following strategic targets:
For destroying enemy equipment, you will receive the following .
points: Command & %emlcal
Control Center Pl ea%) ons
500 Points 500 Points
T-55 Iraqi Battle Tank:
75 Points
T-62 Iragi Battle Tank with Arm
115mm cannon: 150 Points Bunlzler ge?&ons
500 Points 500 Points
ﬁ T-72 Soviet-built Tank with ‘
125mm cannon: 300 Points
SCUD
%,_ G-5 Howitzer - 155mm gun — Missile
with 24 mile range: 75 Points [%E) Launcher g [T
: 500 Points [ II;qullgar
ix¥0 Multidirectional Gunner Stations: ] = - SSSIIignts
D20 5-8 105mm cannons: 150 Points Oil (e ete
Storage
Depot
500 Points

¢ Mi-24 Hind - Soviet Helicopter with Gatlingi
: Guns and antitank missles: 250 Points

MiG-29 Fulcrum - Soviet-built fighter with
ground attack bombs: 350 Points

a% v Mirage F-1 - French-built fighter with
i laser-guided weapons: 350 Points

Military Spending in 1988

1985 dollars Percent of GNP
United States 260,000,000,000 . 64
LISSR - est.9.0-11.0
United Kingdom  22,000,000,000 4.7
West Germany  21,000,000,000 3.0
I'rance 21,000,000,000
Japan 15,250,000,000
Saudi Arabia 14,500,000,000
Ita ly 11,000,000,000
India 8,250,000,000
Canada 8,000,000,000
Iraq 7,000,000,000
South Korea 6,250,000,000
China 5,300,000,000
North Korea 4,000,000,000

You also receive points for picking up POWS and Spoils. Your
score is credited for these items at the end of the mission.

@

Iragi Pow: 75 Points Spoils: 50 Points




Completing the Mission

After completing the objective of the mission, you must proceed to

the extraction location to meet the Armored Assault Transport J
Vehicle. The extraction coordinates are given in the instrument

panel below the current coordinates. (See page 5) ’

If you are more than 30 seconds late for extraction, a penalty is
assessed. The penalty increases with time. If you lose your
bearings, you may display the mission map with Command-M.

After extraction, the Damage Assessment screen is displayed.

lf

: 000230

| POWS CAPTURED: IGIGICIIE
| ASSEIS STIZED: POO®

| TARGEIS DESTROYID: @&

.| POINILS SCORED:

.
RANIK:
COLONEL

-{| Next Mission

At this point, your score is credited for spoils, POWS, and
- strategic targets. Late penalties are also assessed. Your rank is
given at the bottom of the screen:

0-5,000 points  Private
5,000-10,000 Corporal
10,000-15,000  Sergeant
15,000-20,000 Lieutenant

20,000-25,000 Captain
25,000-30,000 Major

30,000-40,000 Colonel
> 40,000 points General

-

U.S. Dependence On Foreign Oil 1

Amount in Btu % of Total Consumption
9 quadrillion 27%
14 quadrillion 37%

(=$35 billion)

Saving the Game

While reviewing the Damage Assessment screen, you may save
the current game by clicking the Save button in the lower left

- corner of the screen. You may not save during the missions. If

you want to save a different copy of the game, click the Save As
button and rename the current game.

The Next Mission

To proceed to the next mission, click the Next Mission button on
the Damage Assessment screen. Complete all twenty missions to
win the war!

Practicing a Mission

You can practice the first nineteen missions by choosing the
Practice command from the File menu. You may make yourself
immortal during practice by choosing the Practice Immortality
command from the Options menu. While practicing, your score is
not saved, and you may not progress between levels.

World Crude Oil Production in 1988
(millions of barrels per day)

USSR 11.68
United States 8.14
Saudi Arabia 5.29
China AT
Iraq ! 2.65
Mexico 251
Iran 2.26
United Kingdom 225
Venezuela 1.90
Canada 1.61
Nigeria 1.44
Indonesia 1.28
Other OPEC 5.87
Other Non-OPEC 8.69
World Total 58.28
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Reference

File menu

Enlist
Starts a new game. Choose this command to receive your first
mission briefing.

Practice

Allows you to practice any mission. While in Practice mode, your
high scores will not be saved, and you may not advance to the next
level.

Open
Opens a saved game file.

Quit

Allows you to quit Desert Storm and returns you to the Finder.

Brief History of Islam

* Islam is the second largest world religion after
Christianity.

* Mohammed, the Prophet, was born in Mecca circa
570 A.D. He died in 632.

* The holiest month of the Islamic calendar is called
Ramadan. It marks the month during which the
central text of Islam, the Koran, was revealed to
Mohammed. Ramadan is observed by fasting
between sunrise and sunset. :

* The Hadith is a sacred text of Islam that contains the
saﬁrings of Mohammed.

* The Koran was revealed to Mohammed by the angel
Gabriel.

* The holiest day of the week for Moslems is Friday.

* The two holiest cities for Moslems are Mecca an
Medina.

* The first two caliphs (successive rulers) of Islam
were Abu Bakr (632-634) and Oman (634-644).

10
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Options menu

Instructions .
Displays instructions for operating the tank and completing the
missions. Click on the Forward and Backward arrows to see more

. information.

Keyboard Setup

Used to change the keyboard setup. The Set Default button makes
the current setup the default. The Load Original Set button returns
the Keyboard Setup to its original numeric keypad configuration.

Sound
Turns the game sounds on and off.

Show/Hide High Scores
Shows and hides the High Scores at the title screen.

Clear High Scores
Erases the current high scores.

Practice Immortality
Choose this command to give yourself an unlimited number of
lives during a practice level.

Specs menu

Combat Specs
Displays information about the enemy’s equipment.

Middle East Countries
Displays facts about the countries in the region. Click on the
Forward and Backward arrows to see more information

* The modern states of the Middle East were formerly
part of the Ottoman Empire.

* The Kuwaiti royal family was established by the
forces of Great Britain.
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Gulf War Battle Map

IRAQ & Baghdad
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In one of the most impressive strategic manoeuvres in military history,
the Allies swung around Kuwait from the west and enclosed the Iragi
armed forces within the newly defined KTO. General Colin Powell
proclaimed, "We are going to cut it off and then we are going to kill
it!" and that is exactly what they did. The Allies bluffed a massive
Marine amphibious assualt. While Saddam amassed his troops in
Kuwait, the Allies completed the destruction of his communications
network. Blind and confused, his troops were easily sealed within
Kuwait. Hussein's already dwindling military options became twofold:
Surrender or face an attack from all fronts.

The outcome is now in the realm of history.....




American War History

April 19, 1775 - Sept. 3, 1783
10,800 American Casualties
Fought against Britain for Independence.

Revolutionary War

War of 1812 June 18, 1812 - Dec. 24, 1815
7,100 American Casualties

Fought against Britain for free trade and sea passage.

Mexican War May 13, 1846 - Feb. 21, 1848
5,900 American Casualties

Fought against Mexico over land disputes.

Civil War April 12, 1861 - April 9, 1865
646,400 American Casualties
Fought between Union and Confederate forces.

Spanish - American War April 25, 1898 - Dec. 10, 1898
4,100 American Casualties

Fought against Spain over the sovereignty of Cuba.

World War 1 April 6, 1917 - Nov. 11, 1918
364,500 American Casualties

Fought against Germany, Austria, and Hungary.

World War 11 Dec. 7, 1941 - Dec. 31, 1946
1,076,250 American Casualties

Fought against Axis Powers (Germany, Italy, and Japan).

Korean War June 25, 1950 - July 27, 1953
157,530 American Casualties

Fought against North Korea.

Vietnam Aug. 4, 1964 - Jan. 27, 1973
211,438 American Casualties
Fought against North Vietnam.

Persian Gulf War Jan. 17, 1991 - Feb. 27, 1991
445 American Casualties

Fought against Iraq over liberation of Kuwait.
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Timeline

1914-18  World War I; Ottoman Empire is dismembered.

1917 British occupy Palestine and issue Balfour Declaration supporting Jewish
homeland there.

1918 British occupy tetritory which becomes Iraq. Iraq becomes a League of Nations
mandate after the war.

1920 Syria and Lebanon become a French League of Nations mandate.

1921 Iraq established as a kingdom under Faisal I. The British maintain military bases.

1921 Military coup in Iran ends British rule.

1922 Palestine becomes British League of Nations Protectorate.

1923 . Transjordan (now Jordan) is created by partition of Palestine.

1930 Nazism and persecution of Jews in Europe increases flow of Jewish immigrants to
Palestine. Friction between Arabs and Jews in Palestine increases.

1932 Saudi Arabia is created with Ibn Saud as king.

1936 Oil is found in Saudi Arabia.

1941 Muhammed Reza Shah Pahlavi begins reign in Iran which lasts until 1979. Rapid
modernization program begins.

1944 Syria becomes independent.

1945 Arab League founded.

1946 Jordan becomes an independent kingdom.

1948 Israel is created in Palestine as a national homeland for Jews.

1948-49  First Arab-Israeli War. Israel repulses invasions by Egypt, Iraq, Jordan, Syria and
Lebanon. Palegtinian refugees flee to Arab countries. Jordan occupies the West

) Bank.

1951 Libya gains independence.

1953 Egyptian republic is established following anti-British unrest. British withdraw
troops in 1954.

1956 Suez Crisis. Egypt’s Nassar nationalizes canal, bringing about invasion by
Britain, France and Israel.

1958 Iraq becomes a republic.

1960 OPEC founded to regulate oil production.

1963 Military rule in Iraq.

1964 Palestinian Liberation Organization founded by Palestinian refugees.

1967 Third Arab-Israeli War (The Six-Day War). Israel captures Sinai, the West Bank,
the Golan Heights, and the Old City of Jerusalem.

1973 Fourth Arab-Israeli War (Yom Kippur War). Egypt, Syria and Iraq attack Israel
on Jewish holy day and are beat back. Arab oil embargo begins, and OPEC
causes massive oil price hike.

1975 Kurdish revolt in northern Iraq is crushed.

1975 Lebanese civil war begins, with Muslim factions rebelling against the Christian
government. Syria invades.

1978-79  Fundamentalist revolution in Iran. Shah is ousted by followers of Ayatollah
Khomeini.

1979 Egypt’s Anwar Sadat signs peace treaty with Israel in exchange
for Israeli pullout from Sinai peninsula.

1979-81  United States embassy personnel are held hostage in Iran by
Khomeini supporters.

1981 President Sadat is assassinated in Egypt.

1982 Israel invades Lebanon to remove PLO militiamen.

1983-84  U.S. peacekeeping force stationed in Beirut. 239 Marines killed by a truck bomb.

1986 United States launches air strike against Tripoli, Libya in response to Libyan
sponsorship of terrorists.

1986 United States admits to secret arms sales to Iran.

1987 Uixited States frigate Stark is hit by Iragi missile in the Persian Gulf; 37 sailors
killed.

1988 U.S. Navy warship shoots down Iranian jetliner, killing 290.

1988 United Nations-sponsored cease fire begins in Iran-Iraq war.

1988 The PLO issues statement renouncing terrorism and recognizing Israel’s right to
exist.

1989 Iran’s Ayatollah Khomeini dies.

1990 Iraq invades Kuwait and threatens invasion of Saudi Arabia.
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Glossary

A-6E
A-10
ACCHAN
ACE
ACLANT
AFSOUTH
AH-1W
AH-64
AV-8B
AWACS
B-52

CBR

CENTAG
CENTCOM

CENTO
F-4G
F-14
F-15
F-16
F-111
F-117A
F/A-18
LAV
M-60
MIA1
M2
MLRS

" NADGE

NATO
NORAD
Patriot
SAC
SACEUR
SALT
SAMOS
SCUD
SEATO
SHAPE
Tomahawk
TOW

Intruder: Carrier based long range bomber
Thunderbolr: Battlefield support jet
Allied Command Channel

Allied Command Europe

Allied Command Atlantic

Allied Forces Southern Europe

Sea Cobra: Attack helicopter

Apache: Battlefield helicopter

Harrier: Ground support jet

Airborne Warning and Control System
Stratofortress: Long Range Bomber
Chemical, Biological, or Radiological agents
used as weapons

Central Army Group

U.S. Central Command headed by H. Norman
Schwarzkopf

Central Treaty Organization

Wild Weasel: Tactical bomber

Tomcat: Air to Air fighter

Eagle: Long range fighter

Falcon: Air combat fighter - Attack jet
Aardvark: Long range tactical fighter-bomber
Stealth: Tactical fighter

Hornet: Carrier based fighter

Light Armored Vehicle

Marine Corps Battle Tank

Abrams: US Main Battle Tank

Bradley: Light Armored Fighting Vehicle
Multiple Launch Rocket System

NATO Air Defense System

North Atlantic Treaty Organization

North American Air Defense Command
American Anti-Ballistic Missile

Strategic Air Command

Supreme Allied Commander Europe
Strategic Arms Limitation Talks

Satellite and Missile Observation Systemn
Soviet Tactical Missile

South East Asia Treaty Organization
Supreme Headquarters Allied Powers in Europe
Computer Guided Cruise Missile

Tube Launched, Optically Tracked, Wire
Guided anti-tank missile system.
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